International Journal of Research

International Journal of Research
Available at https://edupediapublications.org/journals

p-1SSN: 2348-6848
e-1SSN: 2348-795X

=
=
5’%5‘;

Volume 06 Issue 10
September 2019

Universal Remote Control For Home Appliances Using Aduino

Mallepogu Manjula®, S.Mahaboob Basha’
'p.G. Scholar, 2Head Of The Department
12 Branch : Embedded Systems,ECE(M.Tech)
2glectronics and Communication Engineering Department
2Geethanjali College Of Engineering And Technology
Email: * m.manjula750@gmail.com, *syedmahaboob45@gmail.com

ABSTRACT:

With the new inventions and advancements
in technology in the field of electronics, the
desire to live a better life is increasing
day-by-day. The new technologies have
emerged in almost every sector/field like
medical field, industries, aeronautics and
telecommunication and now it has also
entered in domestic’s, which is also
known as home automation.
Apart from their busy and hectic schedule,
human beings want their day to day tasks
to be done on a click of button. The new
technologies and unique methodologies
have tried to fulfill this wish of human
beings to some extent by means of smart
home or home automation.

The main object of home automation is to
provide a wireless communication link of
the home appliances to the remote user and
provide convenience and ease of work.
There are several ways to automate home.
The design and implementation of home
appliance controlling using IR sensors,
LCD, TRIAC and Arduino UNO single
board microcontroller. Here, the IR data is
transferred between IR remote and Arduino
board. TSOP1738 IR-sensor is used to
communicate between remote and Arduino.
And Arduino UNO serves as the controlling
and monitoring unit. It accepts and decodes
the signal received from TSOP 1738 IR
sensor and then the switching application
(turn on/off) is performed through TRIAC.

LCD is used to display the messages and
status of the loads. In software process the
program for this project is written in C
language and uploaded into the memory of
the microcontroller on Arduino board by
Arduino IDE window software. The
operations of the whole circuit are
controlled by software.

Keywords: Arduino UNO board, IR-
sensor, Arduino IDE window software.

INTRODUCTION:

The objective of proposed research work is
to implement such a system that can reduce
efforts, energy losses, provides a
comfortable life, enhance living standards
and can help the elderly, handicapped,
disables as well as the normal beings to
control the home appliances remotely. A
home automation system may be defined as
the technological solution that enables
automating the bulk of electronic,
electrical& technology- based tasks within a
home. It uses a combination of hardware
and software technologies that enable
control and management over appliances
and devices within a home.

A home with an automation system is also
known as a smart home. Since, man’s life
and work are increasingly tight day- by- day
with the rapid growth in communication and
information technology. So there is an
urgent need of such a system that can ease
the day today task and allows access to the
home appliances to the remote user. In the
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proposed research work, we are propagating
the wuse of wireless communication
technology by using IR sensor and single
microcontroller board to allow control over
the electrical home appliances to the remote
user. The proposed system is based on
embedded system i.e. it is a combination of
both hardware and software.

The system consists of two units: one is the
Transmitter section and other is the
Receiver section. Transmitter section
consists of a TV remote and the Receiver
section is consists of a PCB board over
which- an IR Receiver module, dc power
supply, Arduino UNO single board
microcontroller(controlling  unit)  ,zero
crossing detector, ac source and Triac+
optocoupler followed by ac loads is
mounted. The user will send the commands
with the help of remote control and those
signals will be sensed by the receiver IR
module which further sends it to the arduino
board. Arduino decodes the signals and
performs the switch ON/OFF of home
appliance via Triac.

RELATED WORK / LITERATURE
REVIEW

A smart home covers a variety of theoretical
and practical approaches that deals with
living today and in the future. There are
several ways or methodologies to automate
home through wireless communication
technology.

Some of them are as follows:-

(a) SharonPanth&Jivani Mahesh proposed a
methodology to automate home by using
android for mobile phone. Here author
discusses the use of android mobile phone’s
inbuilt facility i.e. Bluetooth to automate
home along with the use of an ATMEL
89C51, 8 bit microcontroller.

(b) PawanSharma &JoshiDeepika has
proposed a methodology about controlling
home appliances through remote operated
master switch via infrared technology. They
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has introduced a unique remote control
circuit to permit the automatic control of
switches and switchboards from a remote
location that does not require any internet
network as well as mobile network or
battery. It was a completely hardware based
system and does not require any software to
control and monitor the system.

(c) Samiran Maiti & Pabitra Kumar Nandi
proposed a solution of home appliance
controlling by the use of IR remote control
signal decoder. Author discusses about the
use of NEC555 timer IC, decade counter,
Triac along with IR sensor to automate
home. It is also a hardware based project.
(d) Monika Rana & Ramandeep Singh
shows an another way to automate home
through a PC Internet-Uno microcontroller
based home automation system. The
proposed system has two operational
modes. The first one is manually-automated
mode and the second one is self automated
mode. The system consists of two main
hardware components: the PC home server
and the arduino-uno microcontroller board.
(e) Naresh P Jawarkar & Vasif Ahmed has
demonstrated  that home  appliance
controlling can also be done by
microcontroller based remote monitoring
using mobile through spoken commands.

(f) Satish Palaniappan & Naveen Hariharan
has shown the ways to provide remote
accessing of home appliances to the user by
using GSM technology and Zigbee
technology.

INTRODUCTION TO EMBEDDED
SYSTEMS:

Application Areas:

Nearly 99 per cent of the processors
manufactured end up in embedded systems.
The embedded system market is one of the
highest growth areas as these systems are
used in very market segment- consumer

electronics, office automation, industrial
automation,  biomedical  engineering,
wireless communication, data
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communication, telecommunications,
transportation, military and so on.

Consumer appliances:

At home we use a number of embedded
systems which include digital camera,
digital diary, DVD player, electronic toys,
microwave oven, remote controls for TV
and air-conditioner, VCO player, video
game consoles, video recorders etc.
Today’s high-tech car has about 20

embedded systems for transmission
control, engine spark control, air-
conditioning,  navigation etc. Even
wristwatches are now becoming

embedded systems. The palmtops are
powerful embedded systems using which
we can carry out many general-purpose
tasks such as playing games and word
processing.

Office automation:

The office automation products using
embedded systems are copying machine,
fax machine, key telephone, modem,
printer, scanner etc.

Industrial automation:

Today a lot of industries use embedded
systems for process control. These include
pharmaceutical, cement, sugar, oil
exploration, nuclear energy, electricity
generation and  transmission.  The
embedded systems for industrial use are
designed to carry out specific tasks such as
monitoring the temperature, pressure,
humidity, voltage, current etc., and then
take appropriate action based on the
monitored levels to control other devices or
to send information to a centralized
monitoring station. In hazardous industrial
environment, where human presence has to
be avoided, robots are used, which are
programmed to do specific jobs. The robots
are now becoming very powerful and carry
out many interesting and complicated tasks
such as hardware assembly.

Medical electronics:
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Almost every medical equipment in the
hospital is an embedded system. These
equipments include diagnostic aids such as
ECG, EEG, blood pressure measuring
devices, X-ray scanners; equipment used in
blood analysis, radiation, colonoscopy,
endoscopy etc. Developments in medical
electronics have paved way for more
accurate diagnosis of diseases.

Computer networking:

Computer networking products such as
bridges, routers, Integrated Services Digital
Networks (ISDN), Asynchronous Transfer
Mode (ATM), X.25 and frame relay
switches are embedded systems which
implement the necessary data
communication protocols. For example, a
router interconnects two networks. The two
networks may be running different protocol
stacks. The router’s function is to obtain
the data packets from incoming pores,
analyze the packets and send them towards
the destination after doing necessary
protocol conversion. Most networking
equipments, other than the end systems
(desktop computers) we use to access the
networks, are embedded systems
Telecommunications:

In the field of telecommunications, the
embedded systems can be categorized as
subscriber  terminals and  network
equipment. The subscriber terminals such
as key telephones, ISDN phones, terminal
adapters, web cameras are embedded
systems. The network equipment includes
multiplexers, multiple access systems,
Packet Assemblers Dissemblers (PADs),
satellite modems etc. IP phone, IP
gateway, IP gatekeeper etc. are the latest
embedded systems that provide very low-
cost voice communication over the
Internet.

Wireless technologies:

Advances in mobile communications are
paving way for many interesting
applications using embedded systems. The
mobile phone is one of the marvels of the
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last decade of the 20th century. It is a very
powerful embedded system that provides
voice communication while we are on the
move. The Personal Digital Assistants and
the palmtops can now be used to access
multimedia services over the Internet.
Mobile communication infrastructure such

as base station controllers, mobile
switching centers are also powerful
embedded systems.

Insemination:

Testing and measurement are the

fundamental requirements in all scientific
and engineering activities. The measuring
equipment we use in laboratories to
measure parameters such as weight,
temperature, pressure, humidity, voltage,
current etc. are all embedded systems. Test
equipment such as oscilloscope, spectrum
analyzer, logic analyzer, protocol analyzer,
radio communication test set etc. are
embedded systems built around powerful
processors. Thank to miniaturization, the
test and measuring equipment are now
becoming portable facilitating easy testing
and measurement in the field by field-
personnel.

Security:

Security of persons and information has
always been a major issue. We need to
protect our homes and offices; and also the
information we transmit and store.
Developing embedded systems for security
applications is one of the most lucrative
businesses nowadays. Security devices at
homes, offices, airports etc. for
authentication and  verification are
embedded systems. Encryption devices are
nearly 99 per cent of the processors that are
manufactured end up in~ embedded
systems.  Embedded  systems  find
applications in. every industrial segment-

consumer  electronics,  transportation,
avionics, biomedical engineering,
manufacturing, process control and

industrial automation, data communication,
telecommunication, defense, security etc.
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Biometric systems using fingerprint and
face recognition are now being extensively
used for user authentication in banking
applications as well as for access control in
high security buildings.
Finance:
Financial dealing through cash and cheques
are now slowly paving way for transactions
using smart cards and ATM (Automatic
Teller Machine, also expanded as Any
Time Money) machines. Smart card, of the
size of a credit card, has a small micro-
controller and memory; and it interacts
with the smart card reader! ATM machine
and acts as an electronic wallet. Smart card
technology has the capability of ushering in
a cashless society. Well, the list goes on. It
IS no exaggeration to say that eyes
wherever we go, we can see, or at least
feel, the work of an embedded system.
HARDWARE IMPLEMENTATION OF
THE PROJECT

This chapter briefly explains about the
Hardware Implementation of the project. It
discusses the design and working of the
design with the help of block diagram and
circuit diagram and explanation of circuit
diagram in detail. It explains the features,
timer programming, serial communication,
interrupts of atmega328 microcontroller. It
also explains the various modules used in
this project.
Project Design :
The implementation of the project design
can be divided in two parts.

— Hardware implementation

- Firmware implementation
Hardware implementation deals in drawing
the schematic on the plane paper according
to the application, testing the schematic
design over the breadboard using the
various IC’s to find if the design meets the
objective, carrying out the PCB layout of
the schematic tested on breadboard, finally
preparing the board and testing the designed
hardware.
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The project design and principle are
explained in this chapter using the block
diagram and circuit diagram. The block
diagram discusses about the required
components of the design and working
condition is explained using circuit diagram
and system wiring diagram.
INTRODUCTION TO
MICROCONTROLLER:

Based on the Processor side Embedded
Systems is mainly divided into 3 types

1. Micro Processor: - are for general
purpose eg: our personal computer

2. Micro Controller:- are for specific
applications, because of cheaper cost we
will go for these

3. DSP ( Digital Signal Processor ):- are
for high and sensitive application purpose
MICROCONTROLLER VERSUS
MICROPROCESSOR:

A system designer using a general-purpose
microprocessor such as the Pentium or the
68040 must add RAM, ROM, 1I/O ports, and
timers externally to make them functional.
Although the addition of external RAM,
ROM, and 1/O ports makes these systems
bulkier and much more expensive, they
have the advantage of versatility such that
the designer can decide on the amount of
RAM, ROM and I/0O ports needed to fit the
task at hand.

In other words, the processor, the RAM,
ROM, 1/O ports and the timer are all
embedded together on one chip; therefore,
the designer cannot add any external
memory, 1/O ports, or timer to it. The fixed
amount of on-chip ROM, RAM, and
number of 1/O ports in Microcontrollers
makes them ideal for many applications in
which cost and space are critical.
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Microprocessor vs. Microcontroller

Microprocessor Microcontroller

CPU is stand alone RAM RAM. 10, CPURAMROMIO and tmer wre all on 2

timer ar sepaate single chip

Designer can decide on the amount of | Fix amount of on chip ROMRAM, 10

ROM, RAM and [0 parts. Ports.

Expansive, Versatility For applications in which cost, power and
space are critical

General purpose Single purpose

Tahle: Microprocessor versus Microcontroller

Block Diagram of the Project

The block diagram of the design is
as shown in the figure below. The brief
description about block diagram is given
below.

Block diagram of proposed system:

. LCD

Power

supply =

AT
ME
GA
328 =) TRIAC | Load2

i TRIAC ﬂ Loadl

IR-
Receiv
er Driver

—N circuit =y Load3

Power Supply:

The input to the circuit is applied from the
regulated power supply. The a.c. input i.e.,
230V from the mains supply is step down
by the transformer to 12V and is fed to a
rectifier. The output obtained from the
rectifier is a pulsating d.c voltage. So in
order to get a pure d.c voltage, the output
voltage from the rectifier is fed to a filter to
remove any a.c components present even
after rectification. Now, this voltage is
given to a voltage regulator to obtain a pure
constant dc voltage.

Voltage regulator:
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As the name itself implies, it regulates the
input applied to it. A voltage regulator is an
electrical regulator designed to
automatically maintain a constant voltage
level. In this project, power supply of 5V
and 12V are required. In order to obtain
these voltage levels, 7805 and 7812 voltage
regulators are to be used. The first number
78 represents positive supply and the
numbers 05, 12 represent the required
output voltage levels.

+HY

GND

12V & BV power supprycil(un' +

Fig: Power supply circuit diagram

ARDUINO UNO:

Arduino is used for building different types
of electronic circuits easily using of both a
physical programmable circuit board
usually microcontroller and piece of code
running on computer with USB connection
between the computer and Arduino.
Programming language used in Arduino is
just a simplified version of C++ that can
easily replace thousands of wires with
words.

2
£
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g
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ARDUINO UNO-R3
COMPONENTS :
ATMEGA328P-PU microcontroller :

The most important element in Arduino
Uno R3 is ATMEGA328P-PU is an 8-bit
Microcontroller with flash memory reach to

PHYSICAL

32k bytes.

Features

1. High  Performance, Low  Power
Atmel®AVR® 8-Bit  Microcontroller
Family

» Advanced RISC Architecture

— 131 Powerful Instructions

— Most Single Clock Cycle Execution

- 32 x 8 General Purpose Working
Registers

— Fully Static Operation

— Up to 20 MIPS Throughput at 20MHz

— On-chip 2-cycle Multiplier

* High Endurance Non-volatile Memory

Segments

— 32KBytes of In-System Self-
Programmable Flash program

2. Memory

— 1KBytes EEPROM

— 2KBytes Internal SRAM

— Write/Erase Cycles: 10,000

Flash/100,000 EEPROM

— Data Retention: 20 years at 85°C/100
years at 25°C(1)

— Optional Boot Code Section with
Independent Lock Bits
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* In-System Programming by On-chip
Boot Program

* True Read-While-Write Operation

— Programming Lock for Software Security

* Atmel® QTouch® Library Support

— Capacitive Touch Buttons, Sliders and
Wheels

— QTouch and QMatrix® Acquisition

— Up to 64 sense channels

3. Atmel-42735B-
ATmega328/P_Datasheet_Complete-
11/2016

* Peripheral Features

— Two 8-bit Timer/Counters with Separate
Prescaler and Compare Mode

— One 16-bit Timer/Counter with Separate
Prescaler, Compare Mode, and Capture
Mode

— Real Time Counter
Oscillator

— Six PWM Channels

— 8-channel 10-bit ADC in TQFP and
QFN/MLF package

» Temperature Measurement

— 6-channel 10-bit ADC in PDIP Package

» Temperature Measurement

— Two Master/Slave SPI Serial Interface

— One Programmable Serial USART

— One Byte-oriented 2-wire Serial Interface
(Philips 12C compatible)

— Programmable Watchdog Timer with
Separate On-chip Oscillator

— One On-chip Analog Comparator

— Interrupt and Wake-up on Pin Change

» Special Microcontroller Features

— Power-on Reset and Programmable
Brown-out Detection

— Internal Calibrated Oscillator

— External and Internal Interrupt Sources

— Six Sleep Modes: Idle, ADC Noise
Reduction, Power-save, Power-down,
Standby, and

4. Extended Standby

* 1/O and Packages

— 23 Programmable /O Lines

— 28-pin PDIP, 32-lead TQFP, 28-pad
QFN/MLF and 32-pad QFN/MLF

with  Separate
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» Operating Voltage:

- 1.8-55V

» Temperature Range:

— -40°C to 105°C

» Speed Grade:

- 0-4MHz @ 1.8 - 5.5V

- 0-10MHz @ 2.7 - 5.5V

- 0-20MHz @ 4.5-5.5V

» Power Consumption at 1MHz, 1.8V,
25°C

— Active Mode: 0.2mA

— Power-down Mode: 0.1pA

— Power-save Mode: 0.75pA (Including 32
kHz RTC)

OTHER ARDUINO UNO R3 PARTS:
Input and Output :

Each of the 14 digital pins on the Uno can
be used as an input or output, using
pinMode 0, digitalWrite(), and
digitalRead() functions. They operate at 5
volts. Each pin can provide or receive a
maximum of 40 mA and has an internal
pull-up resistor (disconnected by default) of
20-50 k Ohms.

In addition, some pins have specialized

functions:

e Serial: 0 (RX) and 1 (TX):
Used to receive (RX) and transmit (TX)
TTL serial data. These pins are
connected to the corresponding pins of
the ATmega8U2 USB-to-TTL Serial
chip.

o External Interrupts: 2 and 3:
These pins can be configured to trigger
an interrupt on a low value, a rising or
falling edge, or a change in value.

e PWM:3 56,9, 10, and 11.
Provide 8-bit PWM output with the
analogWrite() function.

e SPI: 10 (SS), 11 (MOSI), 12 (MISO),
13 (SCK):
These pins support SPI communication
using the SPI library.

e LED: 13:
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There is a built-in LED connected to

digital pin 13. When the pin is HIGH

value, the LED is on, when the pin is

LOW, it's off. The Uno has 6 analog

inputs, labeled AO through A5, each of

which provide 10 bits of resolution

(i.e.1024 different values). By default

they measure from ground to 5 volts,

though is it possible to change the
upper end of their range using the

AREF pin and the analogReference()

function.

Additionally, ~ some  pins  have
specialized functionality:

e TWI: A4 or SDA pin and A5 or SCL
pin. Support TWI communication using
the Wire library. There are a couple of
other pins on the board:

e AREF:

Reference voltage for the analog
inputs. Used with analogReference().

e Reset:

Bring this line LOW to reset the
microcontroller. Typically used to add a
reset button to shields which block the
one on the board.

Memory:

The ATmega328 has 32 KB (with 0.5 KB
used for the bootloader). It also has 2 KB of
SRAM and 1 KB of EEPROM (which can
be read and written with the EEPROM
library).

Communication:

The Arduino Uno has a number of facilities
for communicating with a computer,
another Arduino, or other microcontrollers.
The ATmega328 provides UART TTL (5V)
serial communication, which is available on
digital pins 0 (RX) and 1 (TX). An
ATmegal6éU2 on the board channels this
serial communication over USB and appears
as a virtual com port to software on the
computer. The '16U2 firmware uses the
standard USB COM drivers, and no external

Volume 06 Issue 10
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driver is needed. However, on Windows, a
Anf file is required. The Arduino software
includes a serial monitor which allows
simple textual data to be sent to and from
the Arduino board. The RX and TX LEDs
on the board will flash when data is being
transmitted via the USB-to-serial chip and
USB connection to the computer (but not
for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial
communication on any of the Uno's digital
pins. The ATmega328 also supports 12C
(TWI) and SPlI communication. The
Arduino software includes a

Wire library to simplify use of the 12C bus;
see the documentation for details. For SPI
communication, use the SPI library.

Programming:

The Arduino Uno can be programmed with
the Arduino software (download). Select
"Arduino Uno from the Tools > Board
menu (according to the microcontroller on
your board). For details, see the reference
and tutorials.

The ATmega328 on the Arduino Uno
comes preburned with a bootloader that
allows you to upload new code to it without
the use of an external hardware
programmer. It communicates using the
original STK500 protocol (reference, C
header files).

You can also bypass the bootloader and
program the microcontroller through the
ICSP  (In-Circuit  Serial Programming)
header; see these instructions for details.

The ATmegal6U2 (or 8U2 in the revl and
rev2 boards) firmware source code is
available. The

ATmegal6 U2/8U2 is loaded with a DFU
bootloader, which can be activated by:
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On Revl boards: connecting the solder
jumper on the back of the board (near the
map of Italy) and then resetting the 8U2.

On Rev2 or later boards: there is a resistor
that pulling the 8U2/16U2 HWB line to
ground, making it easier to put into DFU
mode. You can then use Atmel's FLIP
software  (Windows) or the DFU
programmer (Mac OS X and Linux) to load
a new firmware. Or you can use the ISP
header with an external programmer
(overwriting the DFU bootloader).

Description:

The Atmel AVR® core combines a rich
instruction set with 32 general purpose
working registers. All the 32 registers are
directly connected to the Arithmetic Logic
Unit (ALU), allowing two independent
registers to be accessed in a single
instruction executed in one clock cycle. The
resulting architecture is more code efficient
while achieving throughputs up to ten times
faster than conventional CISC
microcontrollers.

Atmel offers the QTouch® library for
embedding capacitive touch buttons, sliders
and wheels functionality into AVR
microcontrollers. The patented charge-
transfer signal acquisition offers robust
sensing and includes fully debounced
reporting of touch keys and includes
Adjacent Key Suppression® (AKS™)
technology for unambiguous detection of
key events. The easy-to-use QTouch Suite
toolchain allows you to explore, develop
and debug your own touch applications.

The device is manufactured using Atmel’s
high  density  non-volatile ~ memory
technology.

The On-chip ISP Flash allows the program
memory to be reprogrammed In-System
through an SPI serial interface, by a
conventional nonvolatile memory
programmer, or by an On-chip Boot
program running on the AVR core.
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The Boot program can use any interface to
download the application program in the
Application Flash memory. Software in the
Boot Flash section will continue to run
while the Application Flash section is
updated, providing true Read-While-Write
operation. By combining an 8-bit RISC
CPU with In-System Self-Programmable
Flash on a monolithic chip, the Atmel
ATmega328/P is a powerful microcontroller
that provides a highly flexible and cost
effective solution to many embedded
control applications. The ATmega328/P is
supported with a full suite of program and
system development tools including: C
Compilers, Macro Assemblers, Program
Debugger/Simulators, In-Circuit Emulators,
and Evaluation Kits.

Configuration Summary:
Feaures ATmegal2dp

in Count it

Rt "
St ¥
EERON B n
Gl O L 7
9 )
i i
{JSART 1
o 1598
A e |
bt 3
164 Tmer/Counters |

Tile:Arfuno Configurfion

Block Diagram:
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Pin Descriptions:

VCC - Digital supply voltage

GND - Ground

Port B (PB[7:0])
XTALL/XTAL2/TOSC1/TOSC2:

Port B is an 8-bit bi-directional 1/0 port
with internal pull-up resistors (selected for
each bit). The Port B output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port B pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port B pins are tri-stated
when a reset condition becomes active, even
if the clock is not running. Depending on
the clock selection fuse settings, PB6 can be
used as input to the inverting Oscillator
amplifier and input to the internal clock
operating circuit Depending on the clock
selection fuse settings, PB7 can be used as
output from the inverting Oscillator
amplifier. If the Internal Calibrated RC
Oscillator is used as chip clock source,
PB[7:6] is used as TOSC[2:1] input for the
Asynchronous Timer/Counter2 if the AS2
bit in ASSR s set.

Port C (PC[5:0]):

Port C is a 7-bit bi-directional 1/0O port with
internal pull-up resistors (selected for each
bit). The PC[5:0] output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port C pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port C pins are tri-stated
when a reset condition becomes active, even
if the clock is not running.

PC6/RESET]:

If the RSTDISBL Fuse is programmed, PC6
is used as an 1/0 pin. Note that the electrical
characteristics of PC6 differ from those of
the other pins of Port C. If the RSTDISBL
Fuse is unprogrammed, PC6 is used as a
Reset input. A low level on this pin for
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longer than the minimum pulse length will
generate a Reset, even if the clock is not
running. Shorter pulses are not guaranteed
to generate a Reset. The various special
features of Port C are elaborated in the
Alternate Functions of Port C section.

Port D (PD[7:0]):

Port D is an 8-bit bi-directional 1/0 port
with internal pull-up resistors (selected for
each bit). The Port D output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port D pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port D pins are tri-stated
when a reset condition becomes active, even
if the clock is not running.

AVCC:

AVCC is the supply voltage pin for the A/D
Converter, PC[3:0], and PE[3:2]. It should
be externally connected to VCC, even if the
ADC is not used. If the ADC is used, it
should be connected to VCC through a low-
pass filter. Note that PC[6:4] use digital
supply voltage, VCC.

AREF:

AREF is the analog reference pin for the
A/D Converter.

ADCJ[7:6] (TQFP and VFQFN Package
Only):

In the TQFP and VFQFN package,
ADCI7:6] serve as analog inputs to the A/D
converter. These pins are powered from the
analog supply and serve as 10-bit ADC
channels.

1/0 Multiplexing:

Each pin is by default controlled by the
PORT as a general purpose I/0O and
alternatively it can be assigned to one of the
peripheral functions. The following table
describes the peripheral signals multiplexed
to the PORT 1/0O pins.

TTYPES OF ARDUINO BOARDS:-

Volume 06 Issue 10
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Arduino UNO.

Arduino MEGA.

Arduino MINI.

Arduino NANO

Arduino DUE.

Arduino YUN.

Arduino Lily pad.

> Arduino Duemilanova.

Apart from this there are many more boards
that can be used. As it’s open source instead
of Arduino you can also find, Freeduino,
Arduino etc. available in the market.
Selection of Board should be done
according to the application.

VVVYVYVYVY VYV

Choosing the right controller:

The table below compares the Arduino
Uno, Leonardo, and our A-Star 32U4 Prime
controllers. The A-Star Primes are based on
the same ATmega32U4 AVR
microcontroller as the Leonardo and ship
with Arduino-compatible bootloaders. The
Primes also offer many advantages,
including superior power management that
enables efficient operation from 2.7V to
118V (LVversion) or 5V to 36V
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(SVversion).

Ardunolno | Ardino |4 gy U Prme A St 3004 Prime

B Leanardo v W
Microcontroller: ATmega328P | ATmega32U4 ATmegad2U4
Clack 602y 16 MHz sl
Tesanator
User[0lines 0 B 26
PWM outputs [ 7 1
Analog inputs [ Vi 12
Ground access ponts 4 4 4
User LEDs: 3 i 3
User pushbuttons: - - 3
Reset button
Power switch
Buzzeroption
microSD option:
LCD option
Arduino-compatible
bootloader
USB comector B Micro-B Micro-B
USBegulator . .
power selection. patil purtil JLANE
High-performance
reverse-voltage
protection
Reconnended WolV | TVolV | 2WolfV | SVilv
Input voltage:
v . . switching switching
Repltortye (V) Tnee fnea step-up/step-down step-down
3Vin — — 0.75A -
Vi — — L3A 024
Availatle t1Vin 10A 10A 1940 104
5V 9V 03A 03A 1940 10A
output atllVin 03354 0334 184 10A
et a4Vin — — — 10A
A TGN YR ¢) 1949
connector
Weight Bg g 3gtad3g

1 There is more available 5 V' output current via VREG, see maximum regulator output current graph for details
2 With sufficient USB power supply.
3 Nominal current available through power MUX with sufficient USB power supply.

LIQUID CRYSTAL DISPLAY:

LCD stands for Liquid Crystal
Display. LCD is finding wide spread use
replacing LEDs (seven segment LEDs or
other multi segment LEDs) because of the
following reasons:

1. The declining prices of LCDs.

2. The ability to display numbers,
characters and graphics. This is in contrast
to LEDs, which are limited to numbers and
a few characters.

3. Incorporation of a refreshing
controller into the LCD, thereby relieving
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the CPU of the task of refreshing the LCD.
In contrast, the LED must be refreshed by
the CPU to keep displaying the data.

4. Ease of programming for
characters and graphics.

These components are “specialized” for
being used with the microcontrollers, which
means that they cannot be activated by
standard IC circuits. They are used for
writing different messages on a miniature
LCD.

A model described here is for its low price
and great possibilities most frequently used
in practice. It is based on the HD44780
microcontroller (Hitachi) and can display
messages in two lines with 16 characters
each. It displays all the alphabets, Greek
letters, punctuation marks, mathematical
symbols etc. In addition, it is possible to
display symbols that user makes up on its
own. Automatic shifting message on display
(shift left and right), appearance of the
pointer, backlight etc. are considered as
useful characteristics.

Pins Functions :

There are pins along one side of the small
printed board used for connection to the
microcontroller. There are total of 14 pins
marked with numbers (16 in case the
background light is built in). Their function
is described in the table below:
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on the power supply voltage and whether
messages are displayed in one or two lines.
For that reason, variable voltage 0-Vdd is
applied on pin marked as Vee. Trimmer
potentiometer is usually used for that
purpose. Some versions of displays have
built in backlight (blue or green diodes).
When used during operating, a resistor for
current limitation should be used (like with
any LE diode).

gV —
5K 30R
_Contrast
. 1 4433013 D LCD Backlight

LCD Basic Commands :

i OO ol i Pesripton All data transferred to LCD through outputs
Gowd L W d DO-D7 will be interpreted as commands or
poversyply 2 s i as data, which depends on logic state on pin
Contrast B e 0-Vdd RS
i I e e s RS =1 - Bits DO - D7 are addresses
: i of characters that should be displayed. Built
bt s kw ) Wiie dma (fon cnoler b LCD) in processor addresses built in “map of
_— | s characters” and displays corresponding
) ke b LD disbed symbols. Displaying position is determined
5k I operting by DDRAM address. This address is either
00 Datdcommandsar e 10 CD previously defined or the address of
Tooooom Bi0LSB previously  transferred  character s
goop Bl automatically incremented.
[ i RS =0 - Bits DO - D7 are commands
O L b which determine display mode. List of
I i commands which LCD recognizes are given
I G s in the table below:
13 D6 " ‘BM
14 D7 1 ‘BiﬂMSB
LCD screen:

LCD screen consists of two lines with 16
characters each. Each character consists of
5x7 dot matrix. Contrast on display depends
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Command RS RW D7 L)ﬁ D5D4 D3 D2 D1 DO Execution Time
Clar display 00 00000 0 01 LodmS
Cussorhome 000 00000 0 1 x [LodmS
Enfrymodeset 00 00000 I DS 40uS
Display on/offcontrol 00 00001 D UB s
Cursor Display Shit 00 000 DCRLx x 40uS
Function set 000 00 DN F x x 40uS
Set CGRAM address 00 0 [ CGRAMaddress 408
SetDDRAMaddress 0 0 1 DDRAMaddress 40us
Read“BUSY"fg (BF) 0 1 BF DDRAMaddres

Witteto CGRAMorDDRAM |1 (0 D7D6 D5 D4 D3 D2 DI DO 40us
Read fom CGRAMorDDRAM 1 |1 D7D6 D5 D4 D3 D2 DI DO 40uS

I/D 1 = Increment (by 1)
R/L 1 = Shift right
0 = Decrement (by 1)
0 = Shift left
S 1 = Display shift on
DL 1 = 8-bit interface
0 = Display shift off
0 = 4-bit interface

D 1 = Display on
N 1 = Display in two lines
0 = Display off

0 = Display in one line
U 1 = Cursoron
F 1 = Character format 5x10 dots
0 = Cursor off
0 = Character format 5x7 dots
B 1 = Cursor blink on
D/C 1 = Display shift
0 = Cursor blink off
0 = Cursor shift

LCD Initialization:
Once the power supply is turned on, LCD is
automatically cleared. This process lasts for
approximately 15mS. After that, display is
ready to operate. The mode of operating is
set by default. This means that:

1. Display is cleared

Volume 06 Issue 10
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2. Mode

DL = 1 Communication through 8-
bit interface

N = 0 Messages are displayed in one
line

F = 0 Character font 5 x 8 dots

3. Display/Cursor on/off

D = 0 Display off

U = 0 Cursor off

B = 0 Cursor blink off

4. Character entry

ID = 1 Addresses on display are
automatically incremented by 1

S = 0 Display shift off

Automatic reset is mainly performed
without any problems. Mainly but not
always! If for any reason power supply
voltage does not reach full value in the
course of 10mS, display will start perform
completely unpredictably. If voltage supply
unit cannot meet this condition or if it is
needed to provide completely safe
operating, the process of initialization by
which a new reset enabling display to
operate normally must be applied.

Algorithm according to the initialization is
being performed depends on whether
connection to the microcontroller is through
4- or 8-Dbit interface. All left over to be done
after that is to give basic commands and of
course- to display messages.
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RS RV D7 06 D5 D4 D3 02 D1 DO Bit5F camot b cecked e tis nsucin,
00001 f xx x| Dilyissetobbtmode

Watbrmon tnd

i

RS RN D7 D DS D4 03 D2 D1 DO | BitPF cannot e ciecked efoe i htuckon
0 00 041 x x xx Dplylssetts bokmode.

Waltfor mor than 100uS

I

RS RW D7 D6 D5 D4 D3 D2 DY DO| BRPF camnot bachecked befors tis nsuction,
000011 xxxx Dpiayisseito&-bi(modo.

Bt PF can bachecked afor the folowing insrctions,

RS R D7 D6 DS 04 D3 D2 D1 DO | The numberofdsplay ines and characte fonthave o be deined and
00001 1HFry Hrege valuescamtot b changed afr i pl

0000001000 Dghyef
0 000000 001 Dislaychear
0000000 1IDS| Eiynotest

|

deslononts Fig: Procedure on $bit nifiazafion

IR Section:
IR TX:

TSAL6200 is a high efficiency infrared
emitting diode in GaAlAs on GaAs
technology, molded in clear, blue grey
tinted plastic packages. In comparison with
the standard GaAs on GaAs technology
these emitters achieve more than 100 %
radiant power improvement at a similar
wavelength. The forward voltages at low

September 2019

current and at high pulse current roughly
correspond to the low values of the standard
technology. Therefore these emitters are
ideally suitable as high performance
replacements of standard emitters.
Features:
o Extra high radiant power and radiant
intensity
o High reliability
e Low forward voltage
e Suitable for high pulse current
operation
o Standard T-1% ([0 5 mm) package
e Angle of half intensity ¢ =+ 17°
e Peak wavelength Ap = 940 nm

e Good spectral matching to Si
photodetectors
Applications:

e Infrared remote control units with
high power requirements
o Free air transmission systems
e Infrared source for optical counters
and card readers
e IR source for smoke detectors
IR Rx:
Description:
The TSOP17.. — Series are miniaturized
receivers for infrared remote control
systems. PIN diode and preamplifier are
assembled on lead frame, the epoxy package
is designed as IR filter. The demodulated
output signal can directly be decoded by a
microprocessor. TSOP1738 is the standard
IR remote control receiver  series,
supporting all major transmission codes.
Features:
o Photo detector and preamplifier in one
package
« Internal filter for PCM frequency
e Improved shielding against electrical
field disturbance
. TTL and CMOS compatibility

. Output active low

. Low power consumption

. High immunity against ambient light
. Continuous  data  transmission

possible (up to 2400 bps)
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. Suitable burst length .10
cycles/burst.
Block Diagram:
)
1.
Tnput Contmal o
Cirew i
/, 3
b ‘ i
(o Band Demodu-
Ay gy
i—' GND

W31
Application Circuit:
1000")

45

2
TSOPIT. | 470

I/ ;
#r’ . Out l
“]

1 {) GND

TSALG.

12108

The circuit of the TSOP1738 is designed in
that way that unexpected output pulses due
to noise or disturbance signals are avoided.
A band pass filter, an integrator stage and an
automatic gain control are used to suppress
such disturbances. The distinguishing mark
between data signal and disturbance signal
are carrier frequency, burst length and duty
cycle. The data signal should fulfil the
following condition:

e Carrier frequency should be close to
center frequency of the band pass (e.g.
38kHz).

o Burst length should be 10 cycles/burst or
longer.

e After each burst which is between 10
cycles and 70 cycles a gap time of at
least 14 cycles is necessary.

e For each burst which is longer than
1.8ms a corresponding gap time is
necessary at some time in the data
stream. This gap time should have at
least same length as the burst.

Volume 06 Issue 10
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e Up to 1400 short bursts per second can
be received continuously.

When a disturbance signal is applied to the

TSOP1738 it can still receive the data

signal. However the sensitivity is reduced to

that level that no unexpected pulses will

occur.

TRIAC:

The TRIAC is an ideal device used for the
AC switching applications. This can control
the flow of current over both halves of an
alternating cycle. The Thyristor can control
only over the one-half of a cycle. The other
remaining half no conduction occurs and
accordingly only half the waveform can be
utilized.

MT1 MT2

G
1.1.1. Construction of TRIAC:
The TRIAC consist of four layers like
PNPN is in the positive direction and the
negative direction consists of NPNP as we
can see in the figure. The three-terminal
bidirectional device blocks the current in the
OFF state and it will act as an open circuit
switch.

i d I

MT;

Gate
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The four triggering modes of operations can
operate by using the I-V characteristics of
TRIAC.

Quadrant | operation: VMT?2, positive; VG1
positive

Quadrant Il operation: VMT21 positive;
VGI negative

Quadrant 11l operation: VMT21 negative;
VGI negative

Quadrant 1V operation: VMT21 negative;
VG1 positive

where VMT21 and VGI are the voltages of
the terminal of MT2 and gate with respect
to terminal MT1.

I-VV Characteristics:

The following figure shows the typical
TRIAC characteristics. The Triode For
Alternating Current consists of ON and OFF
state characteristics which are similar to the
SCR. Now the characteristics are applicable
to both the wvoltages of positive and
negative.

Forward
+1 A Current

ONsate | Mode I+ Mode I-
Conducting
OFF State
Reverse Voltage

Tz + 1+
Blocking Shs i @

Quadrant II Quadrant 1

N \ +V

- % ’ L

Reveread W 6w ™ W W oo SO T Forward
Voktage Gate Voltage
Quadrant 11T Triggered ON
(Conduction)
OFF State
1 I i Forward V otage
-« ON statle Blocking
+ 2 Conducting
Mode III- Mode 11+
Feverse Quadrant IV

1Y Current

IV Characteristics of TRIAC

Advantages of TRIAC:

e In the TRIACs, there will be single
gate control conduction in both the
directions.

o If the voltage is decreased to zero
the TRIAC turns OFF
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o Basically, it is bidirectional device
and in the both the directions it will
conduct.

« High voltage rating are available

Disadvantages:

e It doesn’t fire symmetrically on both
sides of the waveforms
e It doesn’t appropriate for the DC

power
« It has very high switching delay.

Applications:

The TRIACs are using many electrical
switching applications like

e The electric fan speed control

e Smaller motor controls

e Domestic light dimmer

e Control of small AC powered

domestic appliances

BT136 Description:
Glass passivated triacs in a plastic envelope,
intended for use in applications requiring
high bidirectional transient and blocking
voltage capability and high thermal cycling
performance. Typical applications include

motor control, industrial and domestic
lighting, heating and static switching.
PIN DESCRIPTION

1 main terminal 1
2 main terminal 2
3 |gate

tab |main terminal 2

Pin description
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FIRMWARE IMPLEMENTATION OF
THE PROJECT DESIGN

FIRMWARE IMPLEMENTATION:
This chapter briefly explains about the
firmware implementation of the project. The
required software tools are discussed in the
following sections.

Software Tool Required:

Arduino 1.0.6 software tools used to
program microcontroller. The working of
software tool is explained below in detail.
PROGRAMMING
MICROCONTROLLER:

A compiler for a high level language
helps to reduce production time. To
program the Arduino UNO microcontroller
the Arduino is used. The programming is
done strictly in the embedded C language.
Arduino is a suite of executable, open
source software development tools for the
microcontrollers hosted on the Windows
platform.

Arduino is a tool for making computers
that can sense and control more of the
physical world than your desktop computer.
It's an open-source physical computing
platform based on a simple microcontroller
board, and a development environment for
writing software for the board.

One of the difficulties of programming
microcontrollers is the limited amount of
resources the programmer has to deal with.
In personal computers resources such as
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RAM and processing speed are basically
limitless when compared to
microcontrollers. In contrast, the code on
microcontrollers should be as low on
resources as possible

ABOUT ARDUINO COMPILER:

GET AN ARDUINO BOARD AND USB
CABLE:

You also need a standard USB cable (A
plug to B plug): the kind you would connect
to a USB printer, for example. (For the
Arduino Nano, you'll need an A to Mini-B
cable instead.)

CONNECT THE BOARD:

The Arduino Uno, Mega, Duemilanove and
Arduino Nano automatically draw power
from either the USB connection to the
computer or an external power supply. If
you're using an Arduino Diecimila, you'll
need to make sure that the board is
configured to draw power from the USB
connection. The power source is selected
with a jumper, a small piece of plastic that
fits onto two of the three pins between the
USB and power jacks. Check that it's on the
two pins closest to the USB port. Connect
the Arduino board to your computer using
the USB cable. The green power LED
(labelled PWR) should go on.

\ \L
eV at b
o /
' :
v
AN OPEN PROJECT WRITTEN, DEBUGGED AND SUPPORTED <
BY MASSIMO BANZT, DAVID CUARTIELLES, TOM IGOE,
GIANLUCA MARTING AND DAVID MELLIS J
\ -
BASED ON PROCESSING BY CASEY REAS AND BEN FRY \

FIG: OPENING THE ARDUINO WINDOW

Open the blink example:
Open the LED blink example sketch: File >
Examples > 1.Basics > Blink.
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FIG: SOURCE CODE WRITTEN IN ARDUINO COMPILER

Select your board:

You'll need to select the entry in the Tools >
Board menu that corresponds to your
Arduino.

r e B s | @ ‘

FIG: SELECTING AN ARDUINO UNO

WRITING SKETCHES:

Software written using Arduino are
called sketches. These sketches are written
in the text editor. Sketches are saved with
the file extension .ino. It has features for
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cutting/pasting and for searching/replacing
text. The message area gives feedback while
saving and exporting and also displays
errors. The console displays text output by
the  Arduino  environment including
complete error messages and other
information. The bottom righthand corner of
the window displays the current board and
serial port. The toolbar buttons allow you to
verify and upload programs, create, open,
and save sketches and open the serial
monitor.

NB: Versions of the IDE prior to 1.0 saved
sketches with the extension .pde. It is
possible to open these files with version 1.0,
you will be prompted to save the sketch
with the .ino extension on save.

Verify Checks your code for errors.

ng an external programmer. you can hold down the "shift" key on your computer

n. The text will change to "Upload using Programmer”

Presents a menu of all the sketches in your sketchbook. Clicking one will open it within the current

window.

Note: due to a bug in Java, this menu doesn't scroll; if you need to open a sketch late in the list, use
theFile | Sketch book menu instead.
Save Savesyour sketch.

SerialMonitor Opens the serial monitor.

Additional commands are found within the
five menus: File, Edit, Sketch, Tools, Help.
The menus are context sensitive which
means only those items relevant to the work
currently being carried out are available.
1.1.2. SELECT YOUR SERIAL PORT:
Select the serial device of the Arduino board
from the Tools | Serial Port menu. This is
likely to be COM3or  higher
(COM1land COM2 are usually reserved for
hardware serial ports). To find out, you can
disconnect your Arduino board and re-open
the menu; the entry that disappears should
be the Arduino board. Reconnect the board
and select that serial port.

UPLOAD THE PROGRAM:

Before uploading your sketch, you need to
select the correct items from the Tools >
Board and Tools > Serial Port menus.
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The boards are described below. On the
Mac, the serial port is probably something
like /dev/tty.usbmodem241 On Windows,
it's probably COM1 or COM2 (for a serial
board) or COM4, COM5, COM7, or higher
(for a USB board) - to find out, you look for
USB serial device in the ports section of the
Windows Device Manager. On Linux, it
should  be /dev/ttyUSBO,/dev/ttyUSB1 or
similar.

Once you've selected the correct serial port
and board, press the upload button in the
toolbar or select the Upload item from
the File menu. Current Arduino boards will
reset automatically and begin the upload.
With older boards (pre-Diecimila) that lack
auto-reset, you'll need to press the reset
button on the board just before starting the
upload. On most boards, you'll see the RX
and TXLEDsblink as the sketch is
uploaded. The Arduino environment will
display a message when the upload is
complete, or show an error.

When you upload a sketch, you're using the
Arduino bootloader, a small program that
has been loaded on to the microcontroller on
your board. It allows you to upload code
without using any additional hardware. The
bootloader is active for a few seconds when
the board resets; then it starts whichever
sketch was most recently uploaded to the
microcontroller. The bootloader will blink
the on-board (pin 13) LED when it starts
(i.e. when the board resets).

Now, simply click the "Upload” button in
the environment. Wait a few seconds - you
should see the RX and TX leds on the board
flashing. If the upload is successful, the
message "Done uploading.” will appear in
the status bar. (Note: If you have an
Arduino Mini, NG, or other board, you'll
need to physically present the reset button
on the board immediately before pressing
the upload button.)
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FIG: COMPILATION UNDER PROCESS

A few seconds after the upload finishes,
you should see the pin 13 (L) LED on the
board start to blink (in orange). If it does,
congratulations! You've gotten Arduino up-
and-running.

RESULTS AND DISCUSSIONS
WORKING PROCEDURE:

In this project, IR based wireless
communication technology is implemented
along with Arduino UNO single board
microcontroller. The designed circuit has
four units as- a dc power source, controlling
unit (Arduino), Receiver IR module and
switching section which is further connected
to home loads. Arduino is the heart and
brain of this system. It is used to control and
monitor the whole system. Arduino UNO is
a popular open-source single board
microcontroller. Arduino has an 8 bit, 32
pin ATmega328 processor IC. The flash
memory of ATmega328 is 32KB of which
2KB is utilized by bootloader. This board
has 14 digital 1/0 ports of which 6 of them
provide PWM outputs. The operating
voltage of Arduino is 5V. It has 2 ground
pins, 2 reset pins and 1 supply voltage pin.
Arduino is a pre-burned microcontroller
using arduino IDE software, in which codes
are designed and written is usually dumped
into it via computer.

Here, the IR sensor is in-built in remote
which sends the coded infrared signal (as
chosen by the user) to the IR module at the
receiving section. The IR Receiver module
is connected to the Arduino board. The IR
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Receiver module passes the RC5coded data
to the board. Arduino then compares the
received RC5code with the codes stored in
it and then decode it. On the basis of
decoded data/signal, it produces the relevant
outputs i.e. switch ON/OFF of the desired
appliances via BT136 Triac. Two loads are
controlled by TRIAC. The other load is
driven by the transistor. LCD is used to
display the relevant messages.
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